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The Title of the project is “Tamil Virtual University”. This
project is done at Tulsi Infotech, Chennai for Tanjore University. The
Tamil Virtual University aims at providing Internet based resources and
opportunities for the Tamil Communities living in different parts of the
globe as well as others interested in learning Tamil and acquiring
knowledge of the history, art, literature and culture of the Tamils. This
package is developed using Java, JSP and HTML as client’s side
programming and Oracle as the Backend. Designing Tools such as Adobe
Photoshop 6.0, Flash 5.0 are also used. Using JavaScript the form
Validations are done. This package mainly aims in building up a web
portal for this university wherein students of Tamil Virtual University and
general users can access this site, which provides all the details regarding
their subjects, and also about Tamil literature and poetry in Tamil
language. This helps to promote Tamil language through the web. This
site helps us to develop and deliver Internet based learning material in
Tamil language, literature and culture to global Tamil Communities and
others interested. This also deliver customized programmes to meet the
cultural needs of the Tamil Communities in different parts of the world
and help them retain contact with their heritage. Above all this package

has been developed in a user-friendly manner for easier access for the

users.
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COMPANY PROFILE

‘Tulsi is a global technology services company, with a focus on Industry-
Specific Solutions, Strategic Outsourcing and Integration Services. They can address
the most challenging technology issues your company is facing through a unique on-
site, off-site, offshore delivery model that helps you achieve rapid deployment, world-
class quality and reduced costs.

They keep their clients happy by rolling up our sleeves and getting the job
done, tapping a wide-range of outstanding technical capabilities. Their employees
offer a professional heritage spanning Old World legacy systems as well as the New
Economy's leading-edge technologies to deliver innovative business and technical
solutions to today's business leaders.

Tulsi also offers our clients deep industry expertise, particularly in the public
sector and healthcare markets, as well as in numerous other industries, including
retail, distribution, manufacturing, financial services, utilities, telecommunications
and education. But the real differentiator is our ability to offer clients the competitive
advantage of our on-site, offsite, offshore delivery capabilities. With dozens of
locations worldwide, including six development centers, their global delivery model is
transparent, flexible and seamless.

Public and private sector enterprises looking for a consulting and technology
services partner for strategic outsourcing, systems integration or specialized industry
solutions can turn to us with confidence - and with good reason.

A team of professionals manages the Group with expertise in the fields of
Information Technology, Finance, Manufacturing, Marketing, Services and Training.
The operating personnel of TULSI have comprehensive knowledge of competing IT
products from Microsoft, IBM, SUN, and Oracle among others and a cumulative
experience of close to 200 man-years.



At Tulsi, they approach with appropriate technology with innovation and
responsibility to achieve two broad objectives:

Effectively address the business issues our customers face today generate new
opportunities that will help them stay ahead in the future they do this in three distinct
areas. Our IT Services aim at empowering the enterprise. From getting e-businesses
up and going to managing technology infrastructure, they are focused on helping
businesses do their business better. Their Product Design Services help companies
bring defect-free products to market, in time and within budget. Their Service
Provider Solutions address the specialized needs of this market to offer a complete
business and technology offering given our technological depth and breadth they have
developed a common approach that underlies all our areas of operation. Using this,
they consistently deliver solutions that maximize value for our customers. This
approach rests on:

» A robust offshore development methodology that offers the advantages of
parallel development and reduced demand on customer resources.

» A focus on the use of reusable frameworks to provide cost & time benefits
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1. SYSTEM REQUIREMENTS
1.1 Product Definition:

1.1.1 Problem Statement:

The Tamils living in different parts of the world, in order to preserve their cultural
identity and observe their traditions and values, need to maintain familiarity with Tamil
and be knowledgeable .about their heritage. Recognizing this fact and for meeting the felt
and emerging needs of the Tamil Communities and others interested in Tamil studies, the
Chief Minister of the Government of Tamil Nadu, announced at an Intemational Seminar
and Conference on Information Technology in February 1999 that a Tamil Virtual
University (TVU) would be setup. This University has been established in pursuance of
that announcement. The functions of TVU are guided by a Board of Directors and are
administered by a full time Director. So a web portal for Tamil Virtual University is
developed. The Tamil Virtual University aims at providing Internet based resources and
opportunities for the Tamil Communities living in different parts of the globe as well as

others interested in leaming Tamil and acquiring knowledge of the history, art, literature
and culture of the Tamils.

1.1.2 Functions To Be Provided:

The functions of Tamil Virtual University include Internet based Educational
Programmes, Digital Library and Development of Tamil computing. So based on these
Requirements a web portal of Tamil Virtual University is built.

1.1.3 User Characteristics :

This Web portal can be visited by everyone. Some of the common users are

Visitor:
A Registered member of TVU website is a visitor, who can have a look at the

programmes of TVU and can have a glance at the sample contents of the web.
Registration is free.
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Auditor :

One can enroll on payment for auditing any lesson of the academic programmes
for knowledge sake.

Student :

One can enroll on payment as a student of any academic programme. An enrolled

student gets free access to the Library.

Library Member :
One can enroll for the Library Membership by paying annual or life membership

fee. Library Members will have no access to the lessons of the academic programmes.

1.1.4 Solution Strategy :

The problem was approached in a step-by-step fashion. First all the details of this
project is gathered and the analysis is done on the problem definition given by the project
manager. Then the rough draft is made on the analysis and finally ends up in a solution
by breaking the defined problem into modules. The solution is to have a home page as the
first interface for this product. The user can then choose the desired menu option and the

module is automatically called. Thus the solution strategy for this is obtained.

1.1.5 Product features:
This product has many features and is mainly developed to promote Tamil
education through the web. The other features include
¢ To develop and deliver Internet based learning material in Tamil language,
literature and culture to global Tamil Communities and others interested.
¢ To develop and deliver customized programmes to meet the cultural needs of the

Tamil Communities in different parts of the world and help them retain contact

with their heritage.
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¢ To initiate and continue necessary measures to co-ordinate and pool together
knowledge resources, developed in Tamil in different parts of the world, for wider
dissemination.

¢ To offer academic programmes in Tamil Language, literature and culture for audit
or credit and to award appropriate Certificate/Diploma/Degree through Tamil

University, Thanjavur on completion of prescribed requirements.
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2. PROJECT PLAN

2.1 Life Cycle Mode:

The Prototype Model is proposed to be life cycle mode followed while developing
this product. It provides the potential for the rapid development of incremental versions
of this software.

Prototype model

The goal of a prototyping based development process is to counter the first two
limitations of the waterfall model. The basic idea here is that instead of freezing the
requirements before any design or coding can proceed, a throwaway prototype is built to
help understand the requirements. This prototype is developed based on the currently
known requirements. Development of the prototype undergoes design, coding and
testing, but each of these phases is not done very formally. By using this prototype, the
client can get an actual feel of the system, because the interactions with the prototype can
enable the client to better understand the requirements of the desired system. This results

in a more stable requirement that change less frequently.

¢ The development of the prototype typically starts when the preliminary
version of the requirement specification document has been developed.
At this stage there is a reasonable understanding of the system and its
needs and which needs are unclear or likely to change.

¢ After the prototype has been developed, the end users and clients are
given an opportunity to use the prototype and play with it.

* Based on their experience, they provide feedback to the developers
regarding the prototype regarding what is correct and what has to be

' modified.

* Based on the feedback, the prototype is modified to incorporate some

of the suggested changes that can be done easily and then the users and

the clients are again allowed to use the system.
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2.2 Development Schedule:

In Order to complete the project in a given time, the development schedule is

framed and based on the time slots, the product is developed. The development Schedule

consists of milestones and reviews which has been stated below

Terminology/Milestones and Work products:

Task Region 1:
Terminology : Interaction with the Project Leader
Milestones : December 11% to December 13%
Work Product : The Project leader defines about the problem

statement.
Task Region 2:

Terminology : Planning

Milestones : December 18™ to December 20

Work Product :Analysis of the product definition, function the
Product has to perform, Processing environment,
product features ,programming languages and
development tools to be implemented are all

decided in this stage.

Task Region 3:
Terminology : Designing for both the modules
Milestones : December 21% to January 11%
Work Product :Since Design Document plays a vital role in
coding, Preparation of Design Documentation

takes more time. Time limit must be specified

for each module.
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Task Region 4:
Terminology : Coding for both the modules
Milestones : January 18% to February 251
Work Product : Coding for the analyzed product is carried out.

Task Region 5:
Términology : Customer Evaluation
Milestones  : February 26" — March 5%
Work Product :On seeing the performance of the project the
feedback is given and debugging process
takes place

2.3 Team Structure;

A team consisting of 6 members does the Project. The members undertake

different modules of the project

2.4 Documents to be Prepared:
It is suggested that the following documents must be prepared during the time of
the project.
* A system Definition consisting of a product definition and a
project plan.
* A Software Requirement Specification.
* ADesign Document
= A TestPlan

* A properly documented, debugged and tested program.




PROJECT FLAN
h—

2.5 Manner of Demonstration:
Reviews
Every Weekend the completed modules are explained to the Project Leader,
reviewed and inputs are taken.
Documents:
Drafts of every document are reviewed by the Project Leader before it is finalized.

If any changes are there in the draft they are incorporated in the document.
Product:

Demo of each module is shown to the Project Leader when the module is

completed. If any changes are there in the draft they are incorporated in the document.
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3. SOFTWARE REQUIREMENT SPECIFICATION

3.1 PROJECT DESCRIPTION :

Aim Of The Project:

The Tamil Virtual University aims at providing Internet based resources and
opportunities for the Tamil Communities living in different parts of the globe as well
as others interested in learning Tamil and acquiring knowledge of the history, art,

literature and culture of the Tamils.

Detailed Description

The Tamil Virtual University is built to provide Internet based Educational
Programmes, Digital Library and Development of Tamil computing. This web-based
application has lot of facilities for the user like:
TVU at a glance:

This gives us information about the mission, vision and all details regarding
Tamil virtual university.
Academics :

This gives us information about the academics and details about the courses.
One can enroll on payment as a student of any academic programme. An enrolled
student gets free access to the Library. This site offers academic programmes in
Tamil Language, literature and culture for audit or credit and to award appropriate
Certificate or Diploma Degree through Tamil University, Thanjavur on completion of
prescribed requirements
Library :

This gives us information about the books in the library. An enrolled student
gets free access to the Library
Primer Education :

This is developed for small students (around the age of 5) for them to study
Tamil alphabets.

w
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Cultural Gallery:

This gives information about the history, art, literature and culture of the
Tamils.
Sample contents:

A Registered member of TVU website is a visitor, who can have a look at the

programmes of TVU and can have a glance at the sample contents of the web.

Apart from this we have section on Science, Tamil in IT, Glossary and
other links.

The two main modules which are done here include :
e Glossary
e Kamba Ramayanam

Glossary:
This Glossary section a hierarchical flow

Category page

\4
Subject page

v

Publisher’s page

v
Books

Category Page :
Here in this page we have different categories like science, medical science,
Agriculture etc... By clicking into this links this will take us to the subject’s page
where the user can enter according to his choice. From this page itself the User has

the access to go to common Glossary page and he can search for the particular word

by clicking common Search.

L T e
9
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Subject Page :

Here in this page we have different subjects for each category. If the user has
come under science category then he will be provided with access to subjects like
physics, chemistry etc... By clicking into this links this will take us to the publisher’s
page where the user enters according to his choice. From this page itself the User has
the access to go to Glossary page for this particular subject and he can search for the

particular word by clicking Search button

Publisher Page :
Here in this page we have different publications for each subject. Under this
section we have different publication’s like Govt. edition, Ceylon edition etc... By

clicking into this links this will take us to the desired book where the user enters

according to his choice.

o]
Books : \374,5 -
Under this section the glossary for the prescribed book will be given .The ™ -
User can go page by page or he can go to the particular page by typing the page
number. The introduction about the book is also given. In this Glossary page we are
provided with alphabets and by clicking thé particular alphabet we get the
corresponding glossary. This Glossary section has a Flash Keyboard in which we can

enter both tamil as well as English words and find out their meanings.

Kamba Ramayanam :

Thls 1s a part of the Library module. Under this Module the whole epic of
Lord Rama’s life is digitized and presented here for the users. This has all the poems
and the user can go through all the Kandams and he is also provided with word
Search and Numeric Search options with the help of Flash keyboard. The User can
type in the poem number or he can type the beginning of the word and search. The
final result will be got after checking with the database if the poem is found it is

displayed else gives us the message not found.

10 -
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Thus this software is designed with a User interactive and friendly
interface.

3.2 Processing Environment:

3.2.1 Hardware Requirements:

Processor - Any machine from Pentium I

Clock speed - 133 MHZ and above

Hard Disk - 16 MB and above

Operating System - Linux/Unix/Windows 9x/ME/NT
Cache - 256 Cache and above

Monitor - Any Monitor (Color or Black/White)
Keyboard - Windows Keyboard with 104 keys
Mouse - Microsoft compatible Ps/2 Mouse

3.2.2 Software Requirements:
= Java
= Java Server Pages
* HTML
= Oracle 8
= Java Script

* Design Tools - Adobe Photoshop 6.0, Flash 5.0

Web Server - Apache /IS /Netscape Server with servelet engine

3.2.3 Other Requirements:

Tamil Font installation is necessary for viewing this site. If the Tamil
Font installation is not done the Tamil characters will be seen as Junk

Characters.

%

11
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Step-by-step instructions for Tamil Font installation.

For Windows Users:
(a) Click on TAB-LFS-KAMBAN.TTF , TABXPonni

TAMLKAMBAN.TTF (You need TAM font to view Pals dictionary and Madras
University dictionaries)

File Download m

You have choseri t6 download a file from this location,

Tamlka™1.TTF fiom www.tamilvitualuniv.org

What would you like. to do with this fie?
r Opéni this file from its current location

& Save this file to disk

¥ Always ask before opening this type of file

l OK ] Cancel More Info

(b) A window will appear.

Check the option " Save this file to disk" and press Ok.

(ii) A window opens asking for the location for saving file. Select the location

"C:\windows\fonts" and press the button "Save".

12
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(c) If you want to use any other TAM or TAB font, install the desired font in
your system, and do the following:
Click Tools -> Internet options -> Fonts -> set Language script as "User
defined" -> set Web page font as "Desired font" -> click "Ok"

(d) For Intemnet Explorer, please set the encoding to User Defined
Click View->Encoding->User Defined from the browser menu
For Netscape, please set the encoding to User-Defined

Click View->Character Set ->User-Defined from the browser menu

(e) This should let you see Tamil documents in Tamil script.

3.3 Programming Languages and Development Tools:
Programming Languages:
= Java
= Java Server Pages
= HTML
Java Script
Oracle 8

13
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Features of Java Server Pages:
Java Server Pages offers a number of features. They are :

The JSP is platform Independent, both in its dynamic web pages, web servers and
other server components. JSP Pages can be authored on any platform, they can be run
on any web server or web enabled application server.

The Java Server Pages enable the separation of static content from dynamic content
that is inserted into the static template. The Java Server Pages Technology supports
scripting elements as well as actions. Powerful Middle Tier application can be

developed using a web site that uses Java Server Pages technology as a front end.

Features of HTML:

Hyper Text Markup Language is a collection of platform independent Styles
that defines the various components of the World Wide We document. HTML
documents are plain text files that can be created using any text editor. An element is
a fundamental component of the structure of a text document. Some examples of

elements are heads, tables, lists etc. to denote the elements we use tags. HTML 1s not

case sensitive.

Features of Java Script:

Java Script codes can be added to the HTML document by using the script
tag. The different types of variables that can be used in the java script are number,
Boolean, string, null, undefined. Arrays are considered as objects in java script
Java script performs automatic type conversion when used in expréssions and
statements. Java script performs excellent Event Handling Techniques. When the user
submits a form, java script can validate the entire form to check if the user has filled

in every data before the form is sent back to the server. These reduce the workload on

the server.

14
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Features of Oracle 8:

Database applications at work in networked environment can often benefit
from distributing data as well as processing tasks. A distributed database is a
collection of databases that appears to an application as a single, local database. Some
features of Oracle 8 are as follows

1. Oracle 8 can improve throughput performance when replicating
data. Oracle 8 reduces the amount of replicated data propagated
over the network.

2. Oracle 8 supports the fast refresh of most sub query snapshots.

3. Data Replication: Data Replication can improve the performance
of an application and a distributed database system’s network. This
is because the application can access replicate data in a local
database rather than data in a remote database that is available
across the network. Data Replications can increase the availability
of an application because replicate data exists at several locations.
If one location becomes inaccessible due to a system or network
failure alternate data access option exists. Data Replication is
useful to distribute copies of useful information. Oracle’s
Replication features can be used to periodically copy data from a
transaction-processing database to data warehouse,

4. Security :Oracle 8 provides security for client-server systems
especially when they encompass multiple databases.

5. Password Management Enhancements: The new enhancement
feature offered for Password Management in Oracle 8 include
locking, aging and expiration

6. Backup and Recovery: Oracle 8 and its companion management
tool Oracle Enterprise Manager include several new features to
make data base backup and recovery more automated, easier to

use and faster.

iw
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Reasons For Selection of these Software :
Java Server Pages:
Java Server Pages are used in the proposed system, for easy retrieval
of data from the database.
HTML:
HTML is used for implementing frames which contains links to
various pages
Java Script:
Java Script can validate the entire form to check if the user has

filled in every data before the form is sent back to the server. These reduce the

workload on the server.

Oracle 8:

Oracle 8 is chosen for developing the database. The reason behind

the choice of Oracle as the backend in this project are as follows:

¢ For the optimum design of the Database.

e To have a better response time.

e To maintain the security of the Database.

16
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3.4 Dataflow Diagram :

This is one of the various methods to show the flow of data within the module
and is a useful and intuitive way of describing a system. It describes about end-to-end
processing, that is, the flow of processing from when data enters the system to where it
leaves the system can be traced. This Data flow diagram shows how data flows through a
system and how the output is derived from the input through a sequence of functional

transactions.

The various symbols used in the Data flow diagrams are as follows:

, ’ I - Source or Destination of Data

- AProcess:
Process transfers flow of data

- AData store or a Database

BE— - AData flow

V
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Category
User page

Subject
page

I

Publisher
page

'

Book
Page

Description :

This shows us the hierarchical flow of the Glossary Section.

18
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Category
User page

Select
Common
Glossary

Glossary for
All the subjects
Is dlsplayed

Select the
subject and
click ‘alphabet’

. Display the
Glossary correspondin J

glossary

R1 —Request to the Database
R2 - Response from the Database

Description :
This gives information about the Common glossary for all the subjects

present. This displays the value pertaining to the user Input, among the categories in
alphabetical order (i.e) similar to book.

19
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Category
User page

Select
Common
Search

Search Screen
Is displayed

Type the
word to be
Searched

Display the
corresponding

glossary for

the word

Glossary

R1 —Request to the Database
R2 - Response from the Database

Description :

The user can search the meaning of the words by typing it in the textbox
either in Tamil or English. This searches the value pertaining to the user Input, among all
the categories both in Tamil as well as in English

%

20
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, User Kamba
‘ | ‘ yan page

v v v

Bala Ayodhya Aaranya Kishkintha Sundara Yutha
Kandam Kandam Kandam Kandam Kandam Kandam

Select the
poem from th
Kandam
Display the
Kramayan Poem

R1 - Request to the Database
R2 - Response from the Database

Description :

The User can browse through all the poems or can select any particular poem
from any Kandam.

21
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Kamba
User Ramayan page

Bala Ayodhya Aaranya Kishkintha Sundara Yutha
Kandam Kandam Kandam Kandam Kandam Kandam

L l L

Search Search the
Kramayan poem by Word
Retrival Or Number

Display the
Poem

R1 - Request to the Database
R2 - Response from the Database

Description :

The User can search any particular poem from any Kandam by providing its

poem number or the word from the poem.

E

22
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3.5 Functional Specifications:
Functional requirements are typically expressed in relational and

state-oriented notations that specify relationships among inputs, actions and outputs.

Process Description : Category page
The process is to list all the categories for the glossary
page.

Generates  : All the details of the category page.

Receives  : Input for all the details in the category page.
Part Of . Glossary (under TVU).

Derives : All the details of all the category page.
Using : Inputs given from the Database.

Process Description : Subject page
The process is to list all the Subjects for the glossary
page.

Generates  : All the details of the subject page.

Receives  : Input for all the details in the subject page.

Part Of . Glossary (under TVU).
Derives : All the details of all the subject page.
Using : Inputs given from the Database.

Similar Process is done for publisher’s page and Book’s Page

Process Description : Searching for glossary of a particular Word
The process is to search the glossary of a particular
Word and list its Corresponding meaning.
Generates  : Lists the glossary of a particular
Word if it is available in the Database.
Receives  : Input for the particular Word.
Part Of . Glossary (under TVU).

a

23
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Derives  : The Glossary for that Word.
Using . Inputs given from the Database.

Process Description : To Display all the Poems in KambaRamayan
This process show all the Poems from the
particular Topic.

Generates  : All the Poems from the particular Topic.

Receives  : The particular poems that has to be displayed.

Part Of : KambaRamayan (Under TVU).
Derives : The poems from particular Kandam.
Using . Inputs given from the Database.

Process Description : Searching for poems by tying the Word or Number
This process is to display the poem after searching
by its poetry number or by the word.
Generates  : All the poem that has been searched .

Receives  : Poetry number or the word.
Part Of : KambaRamayan (Under TVU).
Derives : The poems from the Database.
Using . Inputs given from the Database

24
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Sample Contents

Primer Education

Cultural Gallery

Home Page Of Tamil Virtual University

This Screen shows the Home Page Of Tamil Virtual Universitywhich has all the
details of these Links.



itskhum - Microsoft Internet Expl

sappreiiue
Social Science

w@sgeaashia)
Medical Science

sredpeL. 100s sevelliie
Vetinary Sciences

e ufflu Qsrgfler g Lefued
Bio - Technology

s & wreflefliue
Arts & Hgmanities

ssad Genfleg velue
Information Technology

Qoo iesluse
Technology

Govarrasranivtt Qumihiue
Agricultural Enginsering

Category page

DESIGN DOCUMENT

siflafluic 5,

Science
sl eflwsed
Law

weney  FPiued
Home Science

Clicking different categories will lead the user to different “subjects “under it.

Common Search searches the value pertaining to the user Input, among all the

categories both in Tamil as well as in English. Common glossary displays the

value pertaining to the user Input, among the categories in alphabetical order (i.e)

similar to book.

M—“ﬁ*
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a

il Virtual Universit icrosoft Internet Explorer

rulled

wullid Qewrena
Agricullure

Camnnanrenoufluiel 1oes il e
Agricufture and Soil Science

Subject Page

This Screen shows the subjects under the Agricultural Engineering Category. This Screen

has Search button and a Glossary button for these subjects.Clicking on the Subjects will
lead into Publisher’s Page
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sowssdific smeb@erdwsarid

Boniws s Qeuehul®

Publisher’s Page

The above screen has various “Publisher’s” mentioned under it. User can select any

Publisher he wants ..
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2% T amil Vitual University - Microsoft Internet Explorer

s ERE ;. Lad i 8] ik pRGionsrer 1
.g,ﬂﬂ“—mm’uﬂ‘r susufled

Gaped
syafbgieny

apariny

SteHpeUE QBT &eit

Book’s Page

Under this section the glossary for the prescribed book will be given. The
introduction about the book is also given The User can go page by page and a Search
button is given in which we can enter both Tamil as well as English words and find out

their meanings.
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M
e et

1sity - Microsoft internet Explorer

Glossary of Agriculture

—_—

English Tamil
machete granule oTQE SenaTa&QaETaes) & mienewr
macro climate Qumeurfl &
macrocyclic oo SIa QUTDSMSES -SRI LI
nacrogyne QaT(pSs QuEEr EoubL

Screen Showing Glossary of Agriculture

In this Glossary page we are provided with alphabets and by clicking the particular
alphabet we get the corresponding glossary. The “mugappu” button takes us to the

previous page.
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T ]

% Tamil Virtual Univessity - Microsoft Internet Explorer

Acricultre
Animalhusbandry
Botany L
BuildingConstruction Uuvwxyz
Chemical Engineering
Chemistry

Civil Engineering
Coramerce
Cormmercialterms ; )
Economics | aundd
Electrical Engineering

A B C DB EFGHIT JK L

Common Glossary Screen

This screen gives information about the Common glossary for all
the subjects present in the Combo box. This displays the value pertaining to the user

Input, among the categories in alphabetical order (i.e) similar to book.
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Glossary of [agicture

HiJBKLMNOPORSTUV W XY Z 3

Screen showing Glossary of Agriculture

The User here clicks the alphabet ‘C’ and the result for it is shown in the next screen.
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amil Virtual University - Microsoft Internet Explorer

Glossary of [agicatwe H

ABCPDEFGHISIKELMNOPORS T TUYVY WXYZ >

English Tomil
cabbage QPLMLECsTs
cabbage wLmLs Gsrs QamasGars
cacao swollen shoot disease Qmadsmoly Grru
cactus saTafEQ sy eums
cactus saraflF Q&g
cactus

Screen showing the result of glossary page

The result screen showing the glossary page for alphabet ‘c’.
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Common Search Screen

This Screen is embedded with a flash keyboard whereby the
user can search the meaning of the words by typing it in the textbox either in Tamil or
English. This searches the value pertaining to the user Input, among all the categories

both in Tamil as well as in English



Tamil Virtual University - Search - Microsoft Internet Exploter

Search Results for cabbage

Fnglish Tamil Subiject
cabbage | oL sCsT& Agriculture
cabbage | pLemLs Cars. QloasCsrs Agricutture

DESIGN DOCUMENT

_Screen showing the Search Result

The Screen showing the Search Result for the English word cabbage.
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Search Screen for Agriculture

Here the User types the word in Tamil and searches for its

corresponding meaning in English.
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Tamil Virtual University - Search - Microsoft Internet Explorer

Search Results for Quiarmfl &resBlencs

Tamil English Subject
Qumeurfl - srafkna | macro.climate | Agriculture

Screen showing the Search Result

The Screen showing the Search Result for the Tamil word.
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Home Page Of Kamba Ramayanam

This Screen shows the first page of the epic and has the links to view other

poems.
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Screen Showing Bala Kandam
This section shows all the poem sunder Bala Kandam which describes about early

 part of Lord Rama’s Life.
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Numeric Search Screen

This Screen is provided for searching the poem by giving its poetry Number.
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&) hitp://localhost:8080/kambaramahtm!/13700001

Search Result Screen

This Screen shows us the result for the Numeric Search.
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% Tamil Virtual Universityt - Microsoft Internet Explorer

) hitp://localhost:8080/k ambarama/htmi/13700001 him

Word Search Screen
This Screen is provided for searching the poem by giving the beginning of the

Word or any word from the Poem

e ————
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. T amil Vitlua! Universityt - Microsoft Intermnet Explorer

Search Result Screen

This Screen shows us the result for the any word from the poem.



DESIGN DOCUMENT

Search Result Screen
This Screen shows us the result for the poem which is begun by the particular

word

L em
e
e ————— et e E———————
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Glossary Table :

This table contains the details of the Glossary Page

Field Name DATA TYPE REMARK
Sno varchar2 (20) Sernial Number
| Pageno number(15) Page Number of the book

English varchar2(300) English words

Tamil varchar2(300) Tamil words

Subject varchar2(300) Subject’s Name

Category varchar2(300) Category’s Name

Book No varchar2(40) Book Number

Kramayan :

This table contains all the details of the Kamba Ramayan book

Field Name DATA TYPE REMARK
PageNo varchar2(20) Page Number of the book
Poetry Lines varchar2(300) Poetry
Poetry Number number(15) Poetry Number
Kandam varchar2(300) Name of the Kandam
Topic varchar2(300) Name of the padalam
TamST varchar2(40) Sub Topic

AL
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5. TEST PLAN

5.1 Objectives of Testing:
The Objectives of testing are as follows:
i. Testing is a process of executing a program with the intent of finding
an error.
ii. A good test is one that has a high probability of finding an
undiscovered error.

iii. A successful test is one that uncovers an as-yet undiscovered error.

5.2 Testability:
Software testability determines how easily a program can be tested.
i.  Operability- The better it works the more efficiently it can be
tested.
ii.  Observability- What you see is what you Test. Incorrect output is

easily identified.
iii.  Controllabilty- The better we control the software. The more the
testing can be optimized.
iv.  Undestandability-The more information we have the smarter we
will test.
5.3 Unit Testing:

Unit testing comprises the set of tests performed by an individual
programmer prior to integration of the unit into a larger system. The situation is
illustrated as follows:

Coding and Debugging ———pUnit testing ——plintegration testing
A Program unit is usually small enough that the programmer who developed it can test
it in great detail and certainly in greater detail than will be possible when the unit is
integrated into an evolving software product. There are four categories of tests that a
programmer will typically perform on a program unit:
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Functional tests

Performance tests > Black Box Test

Stress tests

Structure tests —» White Box Test
Black Box Testing:

This testing focuses on the functional requirements of the software.
Black box testing finds errors in the following functions: Incorrect or
missing functions, interface errors, errors in database access, performance

errors or initialization or termination error.

White Box Testing:
Using the White box testing all the logical decisions on the true and
false side of the product are tested. All the loops within the operational

Bounds are tested. Logical errors and incorrect assumptions are identified
and rectified.

The unit testing for this product is done and shown on the input and

output screen The sample testing for the modules is shown here.

Page Name: Category Page
Labels : Different categories like Science, Agricultural Engineering etc..

Buttons :Common Glossary, Common Search

Input Desired Output | Actual OQutput Comment

Click any Should go to its | Goes to its Verified and

category comresponding | corresponding found to be
subjects subjects correct
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Click Common

Glossary

Click Common

Searqh

Should go to
Common

Glossary Page

Should go to
Common Search

Page

Goes to Common
Glossary
Page

Goes to Common

Search Page

Verified and
found to be

correct

Verified and
found to be

correct

Page Name: Subject Page
Labels : Different Subjects like Agricultural and Agricultural Science.

Buttons : Glossary

Search
Input Desired Output | Actual Qutput Comment
) i Verified and
Click any Should go to its )
) ) Goes to its found to be
Subjects corresponding )
. corresponding correct
Publisher’s page . )
) Publisher’s page Verified and
Click Glossary | Should go to
Goes to Glossary found to be
Glossary Page
Page correct
. Verified and
Click Search Should go to .
Goes to Search Page | found to be
Search Page
correct

Similar Tests are done for Publisher Page and Book’s page.

Page Name: Common Glossary Page

Combo Box: contains all the Subjects.
Buttons : Alphabets from A to Z
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Input Desired Output | Actual Output Comment
Click any Should show Shows Verified and
alphabet Corresponding | Corresponding found to be
Glossary for the | Glossary for the correct
particular particular alphabet
alphabet
Click different | Should show Shows Verified and
subjects from Corresponding | Corresponding found to be
the combo Box | Glossary forthe | Glossary for the correct
particular particular subject
subject
Page Name: Search Screen for Kamba Ramayan
Text Box: Numeric or Word.
Buttons : Numeric Search or Word Search
Input Desired Output | Actual Output | Comment
Type the poem | Should fetch Fetches Verified and found
Number Corresponding | Corresponding | to be correct
Poem from the | Poem from the
Database. Database.
Type the word | Should fetch Fetches Verified and found
From the poem | Corresponding | Corresponding | to be correct
Or  beginning | Poem from the | Poem from the
word Database Database.
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I irrelevant

poem number

or word is typed

Should Display
a warning

message

Displays a
Warning

message

Verified and found

to be correct

Similar tests are done for the entire product.
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6. IMPLEMENTATION

After testing these two modules successfully, the necessary privileges are
given to users. All the users are requested to handle the system properly.
The real time problems that occur are successfully solved.

The objective is to put the tested system into operation. It consists of

o Testing the developed program with sample data.
e Detection and corrections of errors.

e Making necessary changes in the system.

e Testing the user personnel.

o Creating browser compatible files.

¢ Installation of Hardware and Software utilities
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7. CONGCLUSION
Broad conclusions:
With the development of the proposed system, the purpose of the system
is achieved. As the two modules of this software has been implemented, it has
reached positive Feedback .The goals that have been achieved by the developed

system are

0.0

Faster and proved to be user friendly.

.0

Client’s Requirements have been met.

L >

%

Search Results are processed immediately.

Portable and flexible for further development.

°o®
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9. APPENDIX

APPENDIX — A Acronyms

S.No | Acronyms Expansion
TVU Tamil Virtual University
2 JSP Java Server Pages
HTML Hyper Text Markup Language

APPENDIX - B Glossary

TAB-LFS-KAMBAN.TTF, TABXPonni :
Software Used for Tamil font installation.
TAMLKAMBAN.TTF :
Font needed to view Pals dictionary and Madras University dictionaries.
Kambaramayanam :
A Tamil epic.
Kandam :
Section describing about each phases of Lord Rama’s Life History.
Padalam :
Section that comes under KANDAM.
Mugappu :
Go back to Previous Page.
Vaayil:

Home Page




